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This instruction manual will cover how to set up a new projection workbook, how to tie out to your 
actual budget and expenses to AIMS, how to enter monthly projection data and how to enter monthly 
updates to this projection tool. 



Introduction 

This spreadsheet was created by a staff member in Discovery Park as an aid in managing large grants 
and modified for easier use by a staff member in Agriculture.  The excel file, as well as an instruction 
document will be located at the Business Managers website at http://www.purdue.edu/bs‐
ba/Training/SPS_Projection.html. 

This instruction manual is written for Microsoft Excel 2007 files.  Notes, where known, regarding 
differences for lower versions of Excel are noted. 

1) Before Beginning 

Before beginning to set up your projections, there are a few items that you may want to complete to 
make the process easier.  These include making sure you have trusted sites included in your internet 
browser so that exports to Excel will not be blocked and to make sure that you have a file structure 
t upse  in your area. 

a) Adding Trusted Sites 

Follow the instruction located at 
http://help.itap.purdue.edu/viewarticle.php?articleid=3586&searchid=237

984&refid=2 to add trusted sites to your internet browser.  This will enable downloads from 
ugh extra errors. Excel without having to click thro

b) Setting Up Your File Structure 

Before you begin savings files, work with your department to determine the file structure you 
want to use to save your projections.  Having a common file structure within your area should 
help others to be able to find your files in case needed.  Suggested file structure can be found 
below. 

By PI, then by Grant 

By Grant 

2) tt orkbook Se ing Up a New Projection W

a) Review of Workbook Tabs 

This projection workbook has several tabs that make up the entire worksheet.  These tabs are 
discussed below. 

i) Summary Tab 

The summary tab gives an overall look at the entire grant expenditures and projected 
expenditures for each I/O.  This tab allows you to break the budget apart by cost sharing vs. 
sponsor dollars and review the total budget (highlighted orders are cost share accounts, also 
highlighted tabs), expenditures, and commitments through the end of the prior month.  
There is also a monthly account of expenditures for each I/O that lists one full project year 
of expenses (see below). 
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ii) Cumulative Tab 

This tab will add all of the individual I/O tabs together (see below).  This tab is similar to the 
Summary Tab, but it is broken down by sponsored class. 

 

iii) Internal Order (I/O) Tabs 

There will be one I/O tab created for each valid I/O that exists for the grant.  This tab will 
include the details of the expenses to date as well as the projected expenses, similar to 
screenshot above. 
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iv) Keys Tab 

This tab contains project period information as well as the applicable F&A rate for the grant.  
The dates listed on this tab will flow through to all the other data tabs in the workbook.  The 
F&A rate listed here is how the projected F&A dollar amount is calculated on the individual 
I/O worksheets.  The status line is the mechanism the worksheet uses to determine if it 
should be pulling in projected expenses or the actual expenses that have been downloaded 
from AIMS into the projection.  When you have updated monthly information the status 
should be listed as “Closed” with future grant periods left as “Open”.  (See below for 
screenshot.) 

 

v) Account Data Tab 

This tab lists all of the general account data for the grant.  This information will be pulled 
into the I/O sheets (see below). 

 

vi) Previous Tab 

The previous tab is used to capture data from the beginning of the grant through the 
previous month end.  This is data that is copied from the Current tab when updating 
monthly by using the “Move to Previous” button. 
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vii) Current Tab 

The current tab is used to capture data from the beginning of the grant through the current 
month end (similar to screenshot above). 

viii) YYYY‐MM 

This tab is used to capture an individual month’s data.  This tab will be automatically copied 
and renamed for each month (i.e.  June 2008=2008‐12) by clicking the “Generate Monthly 

 Keys tab. Tabs” on the

b) Getting Started 

i) Open GM Aims. 

ii) Type in the grant number on the variable screen.  Leave all other variables blank.  Click OK. 

 

iii) When the grant page is loaded, click on “Export to Excel” button. 

 

iv) Click Open on the pop up screen and an Excel spreadsheet will appear. 

NOTE:  If your spreadsheet does not appear, look at the top of your screen to see if you 
have gotten a pop‐up error (see screenshot below).  If you get this error, click the white bar 
and select Download File.  You will be sent back to the opening portal page.  Go back into 
AIMS and follow the instructions above. (See Section II A. Adding Trusted Sites above to 
eliminate this from happening in the future.)  
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v) If you have two monitors at your desk, follow these steps to create two separate versions of 
Excel to make copying data easier. 

vi) Go to Start> Programs > Excel.  This will open a second session of Excel so that you can view 
the data you downloaded in Excel on one screen and the projection spreadsheet on the 
opposite screen. 

vii) Open the Projection Template spreadsheet (SPS Projection Template) located at : 
http://www.purdue.edu/bs‐ba/Training/SPS_Projection.html 

viii) Click File>Save As> rename the file including the grant number and the current month 
(101XXX_1‐31‐09.xlsm) and save to your area’s appropriate file location. 

ix) Validate that manual calculations are activated.  Click on Formulas> Calculation Options > 
Manual [Tools>Options>Manual for lower versions of Excel].  This will prevent the 
spreadsheet from trying to completely recalculate each time you enter data.  Pressing F9 on 
your keyboard will activate the calculation function.  Ignore any circular reference errors. 

 

x) Click on Options, and highlight the Enable this content radio dial button. 

  
Page 6   

   

http://www.purdue.edu/bs-ba/Training/SPS_Projection.html


 

xi) Save the spreadsheet. 

c) Account Data Tab and Generating Individual I/O Tabs 

i) On the spreadsheet you downloaded from AIMS, copy all the account data listed. 

ii) Paste data into the Account Data tab cell A1.   

iii) Click the Format Data button. 
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iv) The macro will review for any duplicate I/O’s and set‐up the data into the needed format.    
If you have duplicate I/O’s, you will get a message indicating that you must delete the line of 
the unused I/O before proceeding.  Click on the Generate IO Tabs button. 

v) Click on the Generate IO Tabs button. 

 

vi) The macro button will create new tabs at the bottom of the worksheet.  There should now 
be a worksheet for each I/O between the Cumulative and Empty‐xxxxx tabs.  All cost share 
accounts will be highlighted in yellow and will have indirect costs set to 0.  See below. 

 

vii) Be sure to leave the blank Empty‐xxxxx tab in the work

d) Keys Tab & Generating Monthly Data Information Tabs 

sheet. 

i) In GM Aims, Account Summary, click on Grant Info to find the information needed (project 
period) to fill out the Keys Tab. 

ii) Periods Lines:  Enter the first period in your current project year in the yellow cell B1 in 
YYYY‐MM format (e.g. 2008‐11 = May 2008).  (This should correspond to the awarded 
budget period of your grant.) After you leave this cell, the future period and period month 
names (line 6) will automatically change. 

iii) Status Line:  Make sure that the Status line reads “Closed” for each month that has passed 
and “Open” for each month in the future. 

iv) F&A Rate Line:  Validate that the F&A Rate percent listed is correct for your grant.  This 
information can be found by running t‐code GMGRANTD and looking at the OVERHEAD 
COSTS tab.  If you have more than one F&A rate, you will need to make manual 
adjustments.  For example, if all but one I/O use 52.5%, leave the keys tab at 52.5% and 
manually adjust the calculation in the specific I/O tab with the different rate. 
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v) Click on the Generate Monthly Data Tabs (YYYY‐MM) button.   

 

vi) You will get a text box verifying that the correct initial grant year period and status are 
correct.  Check your data and click Yes.  The needed monthly data worksheets will appear in 
between the Current Tab and the YYYY‐MM Tab. 

 

e) Current Tab 

i) In GM Aims, hover over the grant number > right click>Goto>Account Summary 

 

ii) Click the variable button and enter the period range from the beginning of the grant 
through the last month end.  You will want all budget and expense transactions for the 
above period.   

NOTE:  if your grant precedes SAP conversion, you may need to use period 001 of the fiscal 
year your grant began in to include budget set up. 

iii) Validate your total budget and expenses match the Project Financial Report (z_fssr_projfin) 
“Total Grant Cost—excl. CS indirect costs” line through the same period.  Export the GM 
Aims data to Excel. 

iv) Copy the exported data and paste into the Current Tab yellow highlighted cell (B1). Click on 
the Format Data button. 
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v) A reminder to fill in Cell J1 will appear.  Click OK and enter the date your projection is valid 
for.  A button that says Move to Previous will appear.  You do not need to do anything with 
this button at this time.  This will be used when updating the projection at the next month 
end. 

f) Updating the Monthly Data Tabs 

i) The monthly data tabs were created in a previous step. 

ii) In GM Aims Account Summary click on the variable screen button and then enter the month 
you want data (i.e.  011/2008=May 2008).  If screen comes back and says No Data Available, 
then there were no transactions for that period.  Go ahead and leave a blank worksheet. 

iii) Click on “Export to Excel”. 

iv) Click “Open” on the pop up screen. 

v) Copy the data into the appropriate monthly tab (e.g. 2008‐11) in the yellow highlighted cell 
B1. 

 

vi) Click on the Format Data Button.  The macro will review the data for blank lines, remove 
unneeded data, and format the data. 

vii) Continue steps ii‐vi for each month of data (marked closed in the Keys Tab) you need to 
enter.  This data will populate the Summary, Cumulative and I/O tabs.  Be sure to leave a 
blank YYYY‐MM worksheet. 
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g) Review Summary Data and Validate 

i) Press F9 to update your spreadsheet.  This may take a few seconds to calculate (larger 
grants with more IO’s and more months of closed data will take longer to recalculate) 

ii) Validate that your Budget and Expense Columns as well as monthly actual tie out to the 
totals listed in GM Aims or the Project Financial Report.   

NOTE:  Make sure you are only looking at months that have closed and the amounts do not 
include current month transactions. 

 

 

h) Projection Information 

i) Click on the first I/O tab where salary will post.  You can determine this by reviewing the 
Coeus budget, the account set‐up spreadsheet or by running a payroll report 
(zhr_pay_posting) to see who has been charging to the grant and/or I/O.  You can also look 
at the cost distribution report (zhr_cost_distrib) to see who is on this grant in the future. 

ii) You will need to enter the FTE, Staff Member’s name, their monthly salary, choose a staff 
type from the drop down list, and assign a fringe benefit rate.  Links/formulas have already 
been set up to total by staff group and link to the appropriate budget line above. 

 

  
Page 11   

   



iii) If you have AY and/or summer salaries, you may need to manually enter in May, June, July 
and August in the specific I/O tab for an accurate projection. 

iv) You will need to manually add in the dollar amount for graduate fee remits, and S&E items 
you want to project.  The total amounts and F&A will populate once you press F9 and 
recalculate the spreadsheet.   

NOTE: depending on whether the F&A charges on MTDC or TDC will drive whether you will 
need to exclude fee remits, capital equipment, etc from the F&A line; you may need to 
adjust accordingly.  For details on graduate fee remits see the following web page:  
http://www.purdue.edu/sps/proposals/budgethome.html 

v) You can change the FTE of a staff member throughout the project by updated it on the I/O 
spreadsheet.  Prior months will not be affected as once a month is closed out the system 

ctual amounts that charged and disregards the projected information. defaults to the a

i) Additional Options 

i) The summary tab can be copied and the accounts reorganized to provide task or functional 
budgets. 

ii) Sponsor Financial Statements can be created by linking back to the summary or task budget 
tabs. 

iii) An option for reporting on only Co‐PI’s portion of a grant would be to search for the Co‐PI 
on the original GM Aims screen and then do the Account Summary on that grant.  This 
would only include that Co‐PI’s sponsored programs for that grant. 

iv) For additional assistance, see your Business Manager. 

3) Updating the Projection Spreadsheet 

i) Open the previous month’s projection workbook. 

ii) File>Save As> update file name with current month.  

iii) To ensure macros are activated, click on Options, and highlight the Enable this content radio 
dial button. 
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b) Account Data Tab 

i) If any new I/O’s have been added since the projection spreadsheet has been set up, you will 
need to update the Account Data Tab.  (Follow instructions in Getting Started section 

.) above

c) Keys Tab 

i) Change the status to “Closed” for any new months that have closed since the last projection. 

ii) Click on the Generate Monthly Data Tabs (&&&&‐MM) button.  Your new monthly 
ts will be generated. workshee

d) Current Tab 

i) Click on the Move to Previous button. 

 

ii) A dialog box will ask if you are sure you want to move all data from the Current tab to 
Previous.  Click Yes. 

iii) The Previous Tab will now be populated and the Current Tab is empty with the Format Data 
button visible again. 

 

iv) Open GM Aims. 

v) Type in the grant number on the variable screen.  Leave all other variables blank.  Click OK. 

vi) Hover over the grant number > right click>Goto>Account Summary 

  
Page 13   

   



vii) Click the variable button and enter the period range from the beginning of the grant 
through the last month end.  You will want all budget and expense transactions for the 
above period.   

NOTE:  if your grant precedes SAP conversion, you may need to use period 001 the fiscal 
year your grant began in to include budget setup. 

viii) Validate your total budget and expenses match the Project Financial Report (z_fssr_projfin) 
“Total Grant Cost—excl. CS indirect costs” line through the same period. 

ix) After data is validated, click on “Export to Excel” button.  

x) Click Open on the pop up screen and an Excel spreadsheet will appear. 

 

xi) Copy the exported data and paste into the Current Tab yellow highlighted cell (B1).  Click the 
Format Data button.  (Make sure your macros are enabled.) 

xii) You will be prom

e) Monthly Data Tabs 

pted to fill in Cell J1 (month end date). 

i) In GM Aims/Account Summary click on the variable button.  Enter the period of data you 
want.   

NOTE:  If you miss doing projections for a month, you will need to fill in more than one tab. 

ii) Export the data to Excel. 

iii) Copy the monthly data and paste into the appropriate monthly data tab.  

iv) Click on the Format Data button. 

v) Adjust the Projection Information is needed. 

vi) Repeat this process for any new m

f) Review Summary Data and Validate 

onths of data. 

i) Press F9 to update your spreadsheet. 

ii) Validate that the Budget and Expense columns tie out to the totals listed in GM Aims or the 
Project Financial Report for the same periods. 

iii) Compare projected balances to previous months projected balances. Research any large 
changes. 
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g) Tips and Tricks 

i) After opening the file, make sure to maximize your workbook so you can see the tabs at the 
bottom. 

ii) Always start a new projection from the template.  You may have made changes to current 
projections that are specific to that project which could cause problems with new projects. 


